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About this Guide
This document provides configuration instructions for SAS 9.2 Foundation, which is made up of
server‐side Base SAS and a variety of server‐side SAS products (the exact products vary by
customer). Information about the configuration of mid‐tier and client‐side products are available
from your SAS Software Navigator.
The server‐side configuration instructions contained in this document are for the configuration of a
generic SAS server. For information about configuring OLAP, workspace and stored process servers,
please see SAS Integration Technologies: Server Administratorʹs Guide. This material can be found at
http://support.sas.com/documentation/configuration/index.html.
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Chapter 1: Post-Installation Setup for the Metabase Facility
In Version 7 of the SAS System, the SAS/EIS Metabase facility was converted to the V7 Common
Metadata Repository. The Common Metadata Repository is a general‐purpose metadata management
facility that provides common metadata services to various metadata‐driven applications.
Using the Common Metadata Repository requires a one‐time setup of the system the repository
manager. If the repository manager was set up in a previous release it may not need to be set up
again. The steps in the following sections should be completed before you attempt to use the
Metabase Facility. For Metabase Facility users who were using a release prior to Version 7, using the
Common Metadata Repository requires a conversion. For more information, see the Version 8 OLAP
Server Topic “Converting Legacy Metabases.”

Setting Up the System Repository Manager Files
Complete the following steps to set up the necessary system repository manager files. You must have
write access to SASHELP in order to specify the system repository manager.
Note:

1.

This process sets the default location for the repository manager for your site. Individual users may
specify their own repository manager location by following the steps below and not selecting the Write
values to system registry check box.

Create a directory that will be dedicated exclusively to the storage of repository manager files, for
example: !SASROOT\RPOSMGR.
This directory should not be used to store other SAS files.

2.

At a SAS command line, type REPOSMGR and then select Setup Repository Manager.

3.

In the Repository Manager Setup window, Library will default to RPOSMGR. For Path, specify the
path from Step 1, above, and then select the Write values to system registry check box. Then
select OK.

4.

In the resulting dialog window, select Yes to generate the necessary repository manager files.

This completes the setup for the System Repository Manager. You can create additional repository
managers (a user repository manager, for example) by repeating the steps above and by using a
different path.

Registering the SASHELP Repository in the Repository Manager
The SASHELP repository is used in various samples, including the SAS/EIS Report Gallery templates.
Before beginning the steps below, a repository manager must be created (see previous section).
Complete the following steps to register the SASHELP repository in the Repository Manager:
1.

At a SAS command line, type REPOSMGR and then select Repository Registration.

2.

In the Repository Registration window, select New.

3.

In the Register Repository (New) window, type SASHELP (in uppercase) in the Repository field,
and then type the full directory path where the CORE catalog is located in the Path field, for
example:
!SASROOT\CORE\SASHELP
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4.

In the Description field, you can type any character string (for example, SASHELP Repository).
Select OK to close the Register Repository (New) window. Select Close to exit the Repository
Registration window.

Note:

Repositories cannot span multiple directories because the path cannot contain concatenated
directories. If you have existing metabases in concatenated directories, you should copy the
metabases to a single path that will be referenced as a repository.

Converting Version 6 SAS/EIS Metabases to Version 8 Repositories
For step‐by‐step instructions on converting Version 6 metabases to Version 8 repositories, please refer
to the topic “Converting existing SAS/EIS metabases” in the SAS/EIS online Help.
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Chapter 2: Post-Installation Instructions for National Language
Support (NLS)
This chapter contains information on post‐installation configuration for Asian and European
language support.
Important:

To run a localized SAS image, your operating system must be configured to use a Windows
regional setting appropriate to the localized image. You may experience unexpected results if
the regional setting and the localized image are not consistent.
If multiple SAS localizations have been installed on the system, you may need to change the
regional setting for each localized SAS image before invocation. For information on how to
change or to use regional settings, refer to your Microsoft Windows documentation.

Chinese, Japanese, and Korean DBCS Support
This section explains how to change the default settings for the DBCSLANG and DBCSTYPE system
options and how to specify Asian font catalogs.
Note:

The DBCSLANG and DBCSTYPE system options (described in the next section) should be used to set
locale for Asian character sets only. The LOCALE and ENCODING system options, described in the
SAS Help System, are used to set locale for European languages.

Changing the Default DBCSLANG and DBCSTYPE Option Settings
When you install SAS 9.2 Foundation and choose to load NLS language translations, the installation
automatically sets default values for the DBCSLANG and DBCSTYPE system options based on the
language selection and platform. For example, if you install Primary Japanese on Windows 2000, the
configuration file (!sasroot\nls\ja\sasv9.cfg) sets DBCSLANG to JAPANESE and DBCSTYPE to
PCMS.

Changing the Configuration Files for Unicode Server
There are two configuration files. The first, c:\program files\sas\sas 9.2\sasv9.cfg,
points to the second, c:\program files\sas\sas 9.2\nls\1d\sasv9.cfg. To run SAS as a
Unicode Server, edit the configuration files for your system with the following changes:
1.

DBCS settings are in the second configuration file above. Comment‐out the DBCSLANG and
the DBCSTYPE options in that file. For example:
/* -DBCSTYPE PCMS
*/
/* -DBCSLANG JAPANESE */

2.

Add the ENCODING option and set the value to UTF-8 (ENCODING=UTF-8):
-ENCODING=UTF-8

3.

Add the FONT and SYSGUIFONT options and set the values to a TrueType font e.g.,
Thorndale Duospace.
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Asian Font Catalogs
The default configuration files for Asian language editions already contain font definitions.
(However, the configuration file for DBCS extensions does not contain font definitions.) Asian font
catalogs reside in subdirectories (by language) for easy installation. If you want to change the font
catalog, you can specify it in either the configuration file or in your SAS session.
With the exception of Traditional Chinese fonts, Asian fonts reside in the SASHELP.FONTS catalog.
The default configuration file for the Traditional Chinese language edition already contains font
definitions. (However, please note that the configuration file for DBCS extensions does not contain
font definitions.) To use Traditional Chinese fonts, you can specify them either in the configuration
file or in your SAS session.

Installing Traditional Chinese Fonts
To use Traditional Chinese fonts, you must install the Traditional Chinese localization. You will also
need to modify your configuration file, as described in the following section.

Specifying the Font Catalog in the Configuration File for Traditional Chinese Fonts
If you are not running a Traditional Chinese localization but you want to use the Traditional Chinese
fonts, you need to modify the configuration file to set GFONTx to
-set gfontx !SASROOT/nls/zt/font-name
In this statement,
•
•

x represents a value from 0‐9.
font-name represents the name of the font catalog you want to use.

Specifying the Font Catalog in a SAS Session for Traditional Chinese Fonts
To specify the font catalog in a SAS session, submit the following LIBNAME statement:
-libname gfontx !sasroot\nls\langcode\font-name
In this statement,
•
•

x represents a value from 0‐9.
font-name represents the name of the font catalog you want to use.

European Language Support
The following sections explain different methods for configuring your system for locale, describe
how to set up your local session to transfer data to a remote session, and provide a list of devmap and
keymap values that match the locales on your operating system.

Configuring SAS 9.2 for Locale
If you want to configure your SAS session for a locale other than the default locale, you have two
methods from which to choose to achieve that goal. This section explains those methods.
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Changing the Default LOCALE Option Setting
When you install SAS 9.2 Foundation and you choose to load NLS language translations, the
installation automatically sets the LOCALE system option to the default value for the language
installed. The LOCALE option is set in the system configuration file for each language installed.
For example, !SASROOT\nls\fr\sasv9.cfg sets LOCALE to French_France by default.
If you want to change the default locale setting for SAS, you can set the LOCALE system option to the
appropriate language in your system configuration file.
For example, you can edit !SASROOT\nls\fr\sasv9.cfg and change -locale French_France
to -locale French_Canada.

Running SAS in a Different Locale
To set the locale for SAS 9.2 at your site, add the LOCALE system option to your configuration file.
You can find a list of locale values in the SAS 9.2 National Language Support (NLS): User’s Guide.
When you read or write a file, SAS 9.2 expects the data in the external files to be in the session
encoding. To specify a different encoding, refer to the documentation for the ENCODING system
option in the FILENAME, INFILE, or FILE statement in the SAS 9.2 National Language Support (NLS):
User’s Guide.
When LOCALE is set, the ENCODING system option will be set to an encoding that supports the
language for the locale. SAS 9.2 expects user data to be in the encoding that matches the ENCODING
option. If you prefer an encoding other than the most common encoding for the locale, you can also
set the ENCODING system option in the configuration file.
When the ENCODING option is set, the TRANTAB option will always be set to match the ENCODING
system option. The transport format trantabs (translation tables), set by the TRANTAB option, are used
by the CPORT and CIMPORT procedures to transfer SAS data files. These trantabs are also used by the
UPLOAD and DOWNLOAD procedures for transferring files and catalogs, remotely submitting code to
the server, and returning logs and listings to the client.
The Output Delivery System (ODS) will create output using the encoding that matches the
ENCODING system option. If you would like your output created using a different encoding, please
refer to the documentation for the Output Delivery System.
For more information, refer to the Base SAS 9.2 Procedures Guide in base SAS software for
documentation about PROC CPORT and PROC CIMPORT. Refer to the SAS/CONNECT 9.2 User’s
Guide for documentation on PROC UPLOAD and PROC DOWNLOAD.

Additional Information
Depending on the applications you run, additional setup may be required for your system. Refer to the
following sections for more information about configuring your system to run with alternate locales.

Locale Setup on the Remote Server
Note:

The %LS( ) macro was introduced in SAS 9.1. This macro replaced the functionality of the Locale
Setup Window that was used in previous releases.
References to “SAS System 9” in the following section refer to all releases of SAS software
from SAS System 9 forward.
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If you are running SAS System 9 as both your client and server sessions, it is not usually necessary to
run the %LS( ) macro to do any further locale setup. The locale of a server should be compatible
with the locale of your client session; otherwise, your data may be corrupted.
If your SAS System 9 client is connecting to a session running a release of SAS prior to SAS System 9,
you can use the %LS( ) macro to set up the remote SAS environment for data transfer. As the Locale
Setup Window did in previous releases, the %LS( ) macro copies the host‐to‐host translation tables
from the LOCALE catalog into SASUSER.PROFILE. The %LS( ) macro does not set the encoding for
the SAS session.
If you use SAS/CONNECT to connect to a remote SAS server, you will need to set up the server
session for the locale that the SAS client is using. You must set up the server after signing on to the
remote session from the client.
The following examples show how to set locale for remote connections:
Connecting SAS System 9‐to‐SAS System 9: Use the LOCALE option at startup. The LOCALE option
value of the SAS client and server sessions should be the same. For example,
sas -locale Spanish_Spain
Connecting SAS System 9 and a previous release of SAS:
•

SAS System 9 receives the data: Use the LOCALE option on the SAS System 9 side at start up.
Example: sas -locale Spanish_Mexico

•

Previous release receives the data: Start SAS System 9 with the LOCALE option at start up.
Example: sas -locale Spanish_Guatemala

Then use the %LS( ) macro in SAS System 9 to set up the host‐to‐host translation tables on the
previous release after connection is established. For example, submit the following code from the
Program Editor:
%ls(locale=Spanish_Guatemala, remote=on);

Devmaps and Keymaps for SAS/GRAPH Software
If you are running SAS/GRAPH software and you want to display non‐ASCII characters, set the
appropriate devmaps and keymaps to match your current encoding. The devmap and keymap
entries are located in the SASHELP.FONTS catalog. To get the correct devmaps and keymaps for
your encoding, you should use the %LSGRAPH macro.
There are two ways in which the %LSGRAPH macro automatically sets up an environment:
•

copies the devmap and keymap entries that match your encoding to the GFONT0.FONTS
catalog

•

changes the name of the entry to the name DEFAULT so the devmaps and keymaps will be
loaded for you.

The following example uses %LSGRAPH to set the correct devmap and keymap (WLT2) for a Polish
user on the Windows platform:
libname gfont0 'your-font-library';
%lsgraph(wlt2);
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Here is a list of the devmaps and keymaps that match the locales on your platform:
Locale

Devmap and
Keymap Name

Arabic_Algeria
Arabic _Bahrain
Arabic _Egypt
Arabic_Jordan
Arabic_Kuwait
Arabic_Lebanon
Arabic_Morocco
Arabic_Oman
Arabic_Qatar
Arabic_SaudiArabia
Arabic_UnitedArabEmirates
Arabic_Tunisia
Bulgarian_Bulgaria
Byelorussian_Belarus
Croatian_Croatia
Czech_CzechRepublic
Danish_Denmark
Dutch_Belgium
Dutch_Netherlands
English_Australia
English_Canada
English_HongKong
English_India
English_Ireland
English_Jamaica
English_NewZealand
English_Singapore
English_SouthAfrica
English_UnitedKingdom
English_UnitedStates
Estonian_Estonia
Finnish_Finland
French_Belgium
French_Canada
French_France
French_Luxembourg
French_Switzerland
German_Austria
German_Germany
German_Lichtenstein
German_Luxembourg

wara
wara
wara
wara
wara
wara
wara
wara
wara
wara
wara
wara
wcyr
wcyr
wlt2
wlt2
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wbal
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1

Locale

Devmap and
Keymap Name

German_Switzerland
Greek_Greece
Hebrew_Israel
Hungarian_Hungary
Icelandic_Iceland
Italian_Italy
Italian_Switzerland
Latvian_Latvia
Lithuanian_Lithuania
Norwegian_Norway
Polish_Poland
Portuguese_Brazil
Portuguese_Portugal
Romanian_Romania
Russian_Russia w
Serbian_Yugoslavia
Slovakian_Slovakia
Slovenian_Slovenia
Spanish_Argentina
Spanish_Bolivia
Spanish_Chile
Spanish_Colombia
Spanish_CostaRica
Spanish_DominicanRepublic
Spanish_Ecuador
Spanish_ElSalvador
Spanish_Guatemala
Spanish_Honduras
Spanish_Mexico
Spanish_Nicaragua
Spanish_Panama
Spanish_Paraguay
Spanish_Peru
Spanish_PuertoRico
Spanish_Spain
Spanish_UnitedStates
Spanish_Uruguay
Spanish_Venezuela
Swedish_Sweden
Turkish_Turkey
Ukrainian_Ukraine

wlt1
wgrk
wheb
wlt2
wlt1
wlt1
wlt1
wbal
wbal
wlt1
wlt2
wlt1
wlt1
wlt2
cyr
wcyr
wlt2
wlt2
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wlt1
wtur
wcyr
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Chapter 3: Post-Installation Configuration for SAS Accelerator
Publishing Agent Software
The information in this chapter describes the installation and configuration of the SAS Enterprise
Miner Score Export Node and SAS Score Publishing Agent for Teradata. It assumes that you have
already performed the initial SAS Foundation installation, including SAS Accelerator Publishing
Agent and SAS Enterprise Miner Score Export Node, on a Windows machine.

Installing SAS Enterprise Miner Score Export Node
Overview of the SAS Enterprise Miner Score Code Export Node
The Score Code Export node is an extension for SAS Enterprise Miner that exports score code files
that are to be deployed in environments other than SAS Enterprise Miner. An extension is a
programmable add‐in for SAS Enterprise Miner.
The following files are exported by the Score Code Export node:
•
•
•
•

•
•

the scoring program.
an XML file containing scoring variables and other properties.
a second XML file that contains descriptions of the final variables created by the scoring code.
This file can be kept for decision‐making processes.
a SAS data set that is a ten‐row sample of the scored data set showing typical cases of the
input attributes, intermediate variables, and final output variables. This file can be used to
test and debug new scoring processes.
a SAS data set that is a ten‐row sample of the original data and has not been scored by SAS
Enterprise Miner.
a format catalog if any variables in the sample data sets use a user‐defined format.

The following image is how the Score Code Export node appears in the SAS Enterprise Miner process
flow diagram:

Distribution Media
The Score Code Export node is distributed via a ZIP file that contains the following files:
•
•

•

the emscrxpt.cport catalog that contains the nodeʹs entry source file
two images for the node:
o a 16x16 pixel image used on the SAS Enterprise Miner Utility toolbar
o a 32x32 pixel image used to represent the node in the SAS Enterprise Miner diagram
workspace
an XML properties file

The ZIP file is located at <SASHOME>\SASFormatsLibraryForTeradata\9.2\
EMSCENode\SCENode.zip on the machine where you have installed SAS 9.2 Foundation.

Page 9

Configuration Guide for SAS 9.2 Foundation for Microsoft Windows

Installation Requirements
Before you install the Score Code Export node, you must have the following software installed:
•
•

SAS 9.1.3 Service Pack 4
SAS Enterprise Miner 5.3

Installation Instructions
Follow these instructions to install the Score Code Export node:
1.

2.

Copy and unzip the distribution file to a temporary directory on one or both of these
computers:
• the computer where SAS Foundation is installed
• if you are using the SAS Analytics Platform middle‐tier service, on the computer where
the SAS Analytics Platform server is installed.
Use whatever method your system administrator recommends for moving the distribution
file, such as telnet or using a web app.
On the computer where SAS Foundation is installed, do the following:
a. Copy the file emscrxpt.cport to a directory that is accessible to SAS (for example,
C:\sas\emscrxpt.cport).
b. From the Program Editor, either in the SAS windowing environment or SAS Enterprise
Miner, run the following CIMPORT procedure to install the Score Code Export node to
the Sashelp library:
proc cimport infile=’accessible_directory\emscrxpt.cport’
catalog=sashelp.emscrxpt;
run;

3.

4.
5.
6.

If the SAS Analytics Platform middle‐tier server is installed, install the following on the
computer for the middle‐tier server. If the SAS Analytics Platform middle‐tier server is not
installed, install the following on the Enterprise Miner client computer:
a. Copy the CodeExport.xml properties file to the ext directory in the SAS Enterprise
Miner client directory:
...\sas\SASAPCore\apps\EnterpriseMiner\ext
b. Copy the 16x16 and 32x32 pixel images to the gif16 and gif32 directories, respectively:
...\sas\SASAPCore\apps\EnterpriseMiner\ext\gif16
...\sas\SASAPCore\apps\EnterpriseMiner\ext\gif32
Stop all SAS Enterprise Miner 5.3 sessions.
If you are running the SAS Analytics Platform as a middle‐tier service or process, stop and
restart the service or process.
Start your SAS Enterprise Miner 5.3 client.

Verify the Installation
After the installation is complete, use the default values supplied by SAS Enterprise Miner to verify
the installation. When you run the Score Code Export node, the default directory for the output files
is the directory for the project.
To verify the installation, do the following:
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Create a new test project. The Utility tab now displays but is not active.

2.

Specify a datasource.
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3.

Create a diagram for the new project. Click on the Utility tab in the Enterprise Miner client
and look for the Score Code Export node icon as shown in the following display:

4.

Add nodes to the diagram. The last two nodes in the diagram must be the Score node and the
Score Code Export node, respectively.

5.

Right‐click the Score Code Export node icon and select Run.

6.

After the execution completes, verify that the following files were created in the output
directory:
•

score.sas – a file that contains the scoring code.

•

score.xml – a file that contains the scoring properties, such as input and output
variables.

•

emoutput.xml – a second XML file that contains descriptions of the final variables
created by the scoring code. This file can be kept for decision‐making processes.

•

scoredata.sas7bdat – a ten‐row sample of the scored data set showing typical cases
of the input attributes, intermediate variables, and final output variables.

•

traindata.sas7bdat – a ten‐row sample of the original data. It has not been scored by
SAS Enterprise Miner.

If the Score Code Export node icon does not display on the Utility tab, or the output files were not
created in the output directory, contact your SAS field support representative or SAS Technical
Support.

Documentation for Using the SAS Scoring Code Export Node
For information about using the SAS Enterprise Miner Score Code Export node to score models in the
Teradata Enterprise Data Warehouse, see the SAS Scoring Accelerator 1.4 for Teradata: Users Guide
located at http://support.sas.com/documentation/onlinedoc/scoraccl/index.html.

Loading SAS Formats Library for Teradata
The SAS Formats Library for Teradata is a runtime library for formatting routines. Use the process
described in this chapter to load SAS Formats Library for Teradata on your Teradata machine so that
the user‐defined functions (UDFs) created there will have access to routines within its runtime
library.

Increasing the Size of Scoring Model User-Defined Functions
You can increase the maximum size of the scoring model user defined functions by installing a
Teradata DBMS patch that adds the “NS” (“No Save” source) option to the CREATE/REPLACE
function. This new option is used automatically by the scoring model publishing macro if the patch
has been applied; no user intervention is required.
This task should be performed before loading the SAS Formats Library for Teradata. The patch is
included in the following Teradata DBMS versions:
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•
•

06.02.02.34 and above for Linux and MP‐RAS
12.00.01.07 and above for Linux and MP‐RAS

For more information about this option, ask your Teradata support representative and reference
Teradata DR 120829.

Using the Teradata Parallel Upgrade Tool
Before you start the process of loading the SAS Formats Library for Teradata to the machine where
Teradata is running, ensure that the SAS Formats Library package file, jazxfbrs-9.21.4.x86_64.rpm (for V2R6 or TD12) or jazxfbrs-9.2-1.4.pkg (for MP‐RAS), is accessible
from the Teradata machine. If you have completed your SAS Foundation installation, the file can be
found in the following location, based on the type of server you are using, on your SAS Foundation
machine:
•

For V2R6 ‐
<SASHOME>/SASFormatsLibraryForTeradata/9.2/Formats/V2R6/Linux

•

For TD12 ‐ <SASHOME>/SASFormatsLibraryForTeradata/9.2/Formats/TD12

•

For MP‐RAS ‐
<SASHOME>/SASFormatsLibraryForTeradata/9.2/Formats/V2R6/MP-RAS

The following steps should be performed by a Teradata systems administrator. The steps assume
some knowledge of the Teradata Parallel Upgrade Tool (PUT) being used and the environment you
are working within. For more information about using the Teradata Parallel Upgrade Tool, see the
Parallel Upgrade Tool (PUT) for UNIX MPRAS and Linux User Guide, located at
http://www.info.teradata.com/Gen-Srch/eOnLine-Srch.cfm. Download the appropriate
document for your version of Teradata.
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1.

At the Teradata machine, start the Teradata Parallel Upgrade Tool. Log in to PUT using an
account that has permissions to install software on the Teradata system.

2.

The Welcome to the Parallel Upgrade Tool dialog opens. Select Install/Upgrade Software
from the task list and click Next.

3.

The Configuration Mode dialog opens. Select Typical Configuration and click Next.

4.

The Network Subnet Selection dialog opens. Select the correct address for the system you
are applying to from the Subnet Addresses list (typically the BYNET network). Click Next.

5.

The Select Nodes dialog opens. Highlight the node(s) where the SAS Formats Library will be
installed in the Available Nodenames list on the left. You should select all database (TPA)
nodes, then click the right‐hand arrow to move your selection to the Selected Nodename
window. When you have moved all of the appropriate nodes to the right, click Next.

6.

The Select Spool Area for Linux Nodes dialog opens. Read the description on the dialog and
take any steps it describes to choose a location to spool the package on the Teradata nodes.
Click Next.

7.

The Enter Source for New Packages dialog opens. Enter the path to the jazxfbrs-9.21.4.x86_64.rpm file (for V2R6 and TD12) or jazxfbrs-9.2-1.4.pkg (for MP‐RAS) in
the text box. Click Next.
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8.

The Media Source Confirmation dialog opens. Select the No radio button and the Keep it
radio button. Click Next.

9.

The Media Source(s) to be Scanned dialog opens. This dialog is a confirmation of the
choice(s) you made in step 8. Verify the information is correct and click Next. A warning
dialog may appear; if it does, click OK to continue.

10. The Group Nodes dialog opens. You do not need to make any decisions for this dialog. Note
the group(s) that include all of the Teradata database (TPA) nodes in the Teradata system.
Click Next.
11. The Select Packages dialog opens. Only one package should be listed, jazxfbrs. The Group
column will be empty. Click the package.
a.

A window opens with the header Modify package (jazxfbrs) version (9.2‐1.4) OS type
(Linux). Highlight all of the group(s) in the left‐hand widow that include TPA nodes,
then click the right arrow to move those group(s) to the right‐hand window. Click Next.

b. The Select Packages dialog returns, but the Group column has information in it. Click
Next.
12. The Confirm Package Selections dialog opens. Verify the information listed in the dialog
and click Next.
13. Several dialogs that do not require input will go by fairly quickly, depending on your
processor speed. The Teradata Parallel Upgrade Tool is preparing to install. Eventually the
Begin Installing Packages Now? dialog opens. Click Next to begin the installation.
14. After the package is installed, the Overall Package Install Results dialog opens with a
“SUCCESS!” message. Click Next.
15. Several more dialogs that do not require input will go by before the Select Teradata Startup
Option dialog opens. Select the option that is most appropriate and click Next.
16. The Finished! dialog opens. Click Finish and close the Teradata Parallel Upgrade Tool.

Manual Process
V2R6 and TD12
In some cases, such as a single‐node machine installed in a test environment, you may not have
access to the Teradata Parallel Upgrade Tool to load the .rpm file. In those cases, use the following
manual steps to load that file to your Teradata machine. The steps should be performed by a Teradata
systems administrator.
1.

Log in to the Teradata system using an account with permissions to install system software
(generally “root”).

2.

Make jazxfbrs-9.2-1.4.x86_64.rpm available to the Teradata system (network share,
CD‐ROM, copy to file system).

3.

[Optional] Copy the file jazxfbrs-9.2-1.4.x86_64.rpm to a package spool directory of
your choice in order to make a permanent copy on the Teradata system.

4.

Change the directory to the package location.
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5.

From the shell command prompt, enter the following command. No output will be
displayed.
rpm -U jazxfbrs-9.2-1.4.x86_64.rpm

6.

To verify a successful installation, run the following command from the shell command
prompt:
rpm –q jazxfbrs
The following line will be displayed if the installation was successful:
jazxfbrs-9.2-1.4
If you want more information, you can use the following command, but the result will be
more information than you will need to verify your installation.
rpm –qi jazxfbrs

MP-RAS
In some cases, such as a single‐node machine installed in a test environment, you may not have
access to the Teradata Parallel Upgrade Tool to load the .pkg file. In those cases, use the following
manual steps to load that file to your Teradata machine. The steps should be performed by a Teradata
systems administrator.
1.

Log in to the Teradata system using an account with permissions to install system software
(generally “root”).

2.

Make jazxfbrs-9.2-1.4.pkg available to the Teradata system (network share, CD‐ROM,
copy to file system).

3.

[Optional] Copy the file jazxfbrs-9.2-1.4.pkg to a package spool directory of your
choice in order to make a permanent copy on the Teradata system.

4.

Change the directory to the package location, referred to as PKG_LOCATION below.

5.

From the shell command prompt, enter the following command. It is necessary to provide
the full path to the .pkg file.
pkgadd -d /PKG_LOCATION/jazxfbrs-9.2-1.4.pkg jazxfbrs
The following output will result:
Installation in progress. Do not remove the installation media.
Processing package instance <jazxfbrs> from
</PKG_LOCATION/jazxfbrs-9.2-1.4.pkg>
jazxfbrs
Version 9.2-1.4 (x86)
SAS Institiute Inc.
Using </usr/lib> as the package base directory.
## Spooling part 1.
## Processing package information.
## Processing system information.
2 package pathnames are already properly installed.
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## Verifying disk space requirements.
Installing jazxfbrs as <jazxfbrs>
## Installing part 1 of 1.
## Verifying all files in the package.
## Checking Update Directory
Installation of <jazxfbrs> was successful.
6.

To verify a successful installation, run the following command from the shell command
prompt:
pkginfo jazxfbrs
The following will be displayed if the installation was successful:
application jazxfbrs

jazxfbrs

If you want more information, you can use the following command, but the result will be
more information than you will need to verify your installation.
pkginfo -l jazxfbrs
Note: If you intend to use a SAS 9.1.3 machine as a Teradata EDW client to access this library,
that machine must have SAS 9.1.3 Service Pack 4 and hot fix E9BC32 applied to it.
Download and install Service Pack 4 and hot fix E9BC32 from the SAS Technical Support
Hot Fixes site, http://ftp.sas.com/techsup/download/hotfix/hotfix.html.

Documentation for Using SAS Formats Library for Teradata
For information about how to use your newly installed software, see the SAS Scoring Accelerator 1.4
for Teradata: Userʹs Guide located at
http://support.sas.com/documentation/onlinedoc/scoraccl/index.html.
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Chapter 4: SAS/ACCESS Interfaces
Configuring SAS/ACCESS Interface to MySQL Software
Before you can use SAS/ACCESS Interface to MySQL software, the following products are required:
•
•

Base SAS software
SAS/ACCESS Interface to MySQL software

Before you use SAS/ACCESS interface to MySQL software, verify that the MySQL client library has
been appended to Path, a system variable. The MySQL client library is often located in
C:\mysql\bin.
To locate the Path system variable, follow the instructions for your operating system.
•

For Windows NT, right‐click My Computer and choose Properties. Select the Environment
tab and you will see in your list of system variables.

•

For Windows 2000, right‐click My Computer and choose Properties. Select the Advanced tab
and select the Environment Variables button. You will see Path in your list of System
Variables.

•

For Windows XP, click Start then select Control Panel. Double‐click System. Select the
Advanced tab and select the Environment Variables button. You will see Path in your list of
System Variables.

If you use MySQL Client version 4.1.0 or later, you will need to make a change because of client
incompatibilities. The SASMYL SAS option must be updated so that the SAS/ACCESS Interface to
MySQL can identify your version of the MySQL client. This can be done either in the beginning of
your SAS program or in your SASV9.cfg file.
If you want to set the SASMYL option in your SAS Program, add the following line at the top of your
SAS program:
options set=SASMYL MYWIN417
The SASV9.cfg file is located in your !SASROOT directory. To set the SASMYL SAS option in your
config file, add the following line
-set SASMYL MYWIN417
For more information about SAS/ACCESS Interface to MySQL, refer to the MySQL chapter in
SAS/ACCESS 9.2 for Relational Databases: Reference.

Configuring SAS/ACCESS Interface to ODBC Software
Before you can use SAS/ACCESS Interface to ODBC software, the following products are required:
•
•
•

Base SAS Software
SAS/ACCESS Interface to ODBC Software
A 32‐bit ODBC driver for the source from which you want to access data

The ODBC solution allows different technologies to be used by defining a standard interface.
SAS/ACCESS Interface to ODBC software with ODBC drivers provides you with access to different
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databases. An ODBC driver processes ODBC function calls from‐‐and returns results to‐‐
SAS/ACCESS software. You can get drivers from Microsoft, your database vendor, or other third
party software vendors.
To run SAS/ACCESS software on 32‐bit Windows, you need 32‐bit drivers. The application calls the
32‐bit Driver Manager (ODBC32.DLL), which in turn calls the 32‐bit drivers. The following figure
illustrates the architecture:

SAS/ACCESS

32-Bit Driver Manager
(ODBC32.DLL)

32-Bit Driver

32-Bit Driver

32-Bit Driver

Data Source

Data Source

Data Source

The ODBC Driver Manager and Administrator are Microsoft products that are included with all
ODBC drivers. When you install an ODBC driver, the ODBC Driver Manager and Administrator are
also installed. The ODBC Administrator should appear as an icon in the control panel. However, it
can appear as an icon in the Start menu instead.
After you install the ODBC driver, you can use the ODBC Administrator to define and manage the
data sources. A data source associates a particular ODBC driver with the data you want to access
through that driver. It can consist of information about the data you want to access and its associated
operating system, DBMS, and network platform (if any) used to access the DBMS. For information
about how to configure your data sources, refer to the documentation provided with your ODBC
drivers.
For more information about SAS/ACCESS to ODBC, refer to the ODBC chapter in SAS/ACCESS 9.2
for Relational Databases: Reference. For more information about ODBC, refer to Microsoft ODBC 3.0
Programmer’s Reference and SDK Guide.

SAS/ACCESS ODBC Conversion Utilities
The SAS/ACCESS ODBC Conversion Utilities are included in the SAS/ACCESS Interface to ODBC
software. It helps users of Version 6 SAS/ACCESS Interface to AS/400 and SAS/ACCESS Interface to
Microsoft SQL Server move from a native DBMS interface connection to an ODBC interface
connection on SAS 9.2.

AS/400 Users
Before you can use the ODBC Conversion Utilities for AS/400 Interface, you need to install IBM’s
Client Access ODBC Driver (32‐bit) V3.00.0004 or above. If your AS/400 Client Access installation
loaded a Client Access ODBC Driver prior to this release, you can download Program Temporary Fix
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(PTF) SF59504 or later from ftp://ftp.software.ibm.com/ for an update. This service pack for
the Client Access product can be found in the
/as400/products/clientaccess/win32/v3r1m2/servicepack/ directory. When this
update is applied, Version 3.00.0004 or later of the ODBC driver should be installed.
You are also required to create a data source name. You can use the ODBC administrator to add it.
The data source name AS400 is recommended. If you want to use another data source name, set the
SAS environment variable AS400DSN, located in your sasv9.cfg, to the data source name you
assigned. Quotes are required if blanks or special characters are included. You may want to create it
as a system DSN instead of a user DSN if you have more than one user who might want to use the
same workstation to access the AS/400 database.
Complete the following steps to create a data source for AS/400 database access:
1.

Run ODBC Administrator from the Control Panel or Start menu: Start > Settings > Control
Panel > (Admin Tools> on XP) Data Sources (ODBC).

2.

Click the User DSN or System DSN tab, depending on the number of users.

3.

Click the Add button and then choose Client Access ODBC driver (32‐bit) from the pop‐up
windows.

4.

Click Finish. This brings up the Setup dialog.

5.

Click the General tab and enter AS400 (or another name) in the Data Source Name field. This
name needs to match the value you set for the SAS environment variable AS400DSN.

6.

From the pull‐down menu, choose an AS/400 system that you want to connect to using this
data source.

7.

To change the method that this data source will use to connect, click Connection Options.
Select the appropriate option and click OK.

8.

Click the Server tab. The default library is QGPL. You can change this designation by
deleting its name from under the Default Libraries filed and either entering a new library to
use or leaving it blank.

9.

Click the Format tab. Using the Naming Convention pull‐down list, select System naming
convention (*SYS).

10. Click the Package(s) tab. Uncheck the box for Enable Extended Dynamic Support.
11. Click OK to close the Setup window.

Microsoft SQL Server Users
An ODBC Conversion Utility is provided that will allow you to read SAS System Version 6 views to
access data in Microsoft SQL Server which were created with SAS/ACCESS Interface to Sybase and
SQL Server software on Windows. The Conversion Utility helps users migrate to SAS/ACCESS
Interface to ODBC software on Windows.
Note:

The Conversion Utility applies only to views that access data in Microsoft SQL Server. It does not
apply to SYBASE SQL Server.

The ODBC Conversion Utility requires the Microsoft SQL Server ODBC driver (32‐bit) from
Microsoft. This driver is installed as part of Microsoft Data Access Components (MDAC).
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It is recommended (but not required) to create a data source name. You can use ODBC administrator
to add it. You must set the SAS environment variable MSSQLDSN, located in the sasv9.cfg, as the
data source name you assigned. Quotes are required if blanks or special characters are included. You
can create it as a system DSN instead of a user DSN if you have more than one user who may use the
same workstation to access the Microsoft SQL Server database.
Complete the following steps to create a data source for Microsoft SQL Server database access:
1.

Run ODBC Administrator from the Control Panel or Start menu.

2.

Click the User DSN or System DSN tab, depending on the number of users, as stated above.

3.

Click the Add button and choose SQL Server from the pop‐up window.

4.

Enter any name in the Name field. This name needs to match the value you set for the SAS
environment variable MSSQLDSN.

5.

Choose or enter the Server field which you defined using SQL Client Configuration Utility.

6.

Click Next. Select the radio button that describes your login method. If necessary, enter a
login ID and password.

7.

Click Next. A connection will be initiated. If the connection succeeds, please refer to Step 8
below. If the connection fails, an error message will provide a reason for the failure.

8.

After a connection succeeds, your default databases may be changed. Click Next to leave this
screen.

9.

After changing your default databases, other options may be selected. Click Finish when this
screen is correct.

10. Click Test Data Source. After a message appears that indicates that the test was successful,
click Okay. Click Okay on the following message as well.
Note:

SAS 9.2 will automatically install Microsoft Data Access Components (MDAC) when you install
SAS/ACCESS Interface to ODBC software.

Configuring SAS/ACCESS Interface to Oracle Software
Before SAS/ACCESS Interface to Oracle software can be used, the following products are required:
•
•
•

Base SAS software
SAS/ACCESS Interface to Oracle software
Oracle client/server, Release 9i or above

After the Oracle client/server installation process is complete, ensure that the path to the Oracle client
libraries is appended to the PATH system variable. The Oracle libraries are usually located in the
directory ORACLE_HOME/bin. If the PATH variable does not have ORACLE_HOME/bin, you will see
the following error:
ERROR: The SAS/ACCESS Interface to ORACLE cannot be loaded.
ERROR: Image SASORA found but not loadable.
For more information about SAS/ACCESS Interface to Oracle, refer to the Oracle chapter in
SAS/ACCESS 9.2 for Relational Databases: Reference.
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Configuring SAS/ACCESS Interface to SYBASE Software
In SAS 9.2, the administrator or user must install a Sybase‐stored procedure on the target server. Two
files have been included in the !SASROOT\access\misc directory to assist in the installation:
•

sas-spcp.txt is a text file containing instructions on how to do the installation.

•

sas-spdf.txt is the actual stored procedure script. The process utilizes two Sybase
facilities, defncopy and isql.

Configuring SAS/ACCESS Interface to Teradata Software
Before using SAS/ACCESS Interface to Teradata software, you should verify connectivity by logging
into your Teradata account with the Teradata BTEQ utility. If BTEQ is unavailable, establish
connectivity as documented in the SAS/ACCESS to Teradata white paper, available at
http://support.sas.com/resources/papers/teradata.pdf.
If BTEQ fails to connect to the Teradata server, you may need an entry in the hosts file on your PC to
provide the network address of the Teradata server. Typically, this means adding a dbccop1 entry to
your hosts file. For more details about the entry, see your Teradata Client for Windows Installation
Guide.

FastExporting
For optimal reads of large tables, SAS/ACCESS can perform FastExporting. To perform FastExporting,
the Teradata FastExport Utility must be present on the system where you install SAS. You must also
modify Path, a system variable. Append two directory paths to the end of Path:
1.

The directory where fexp.exe (the FastExport Utility) is located. Often this is C:\Program
Files\NCR\Teradata Client\bin.

2.

The directory where sasaxsm.dll is located (sasaxsm.dll is usually located in your SAS
product tree, in the !sasroot\core\sasext directory.)

To locate the Path system variable, follow the instructions for your operating system:
•

For Windows NT, right‐click My Computer and chose Properties. Select the Environment
tab and you will see Path in your list of System Variables.

•

For Windows 2000, right‐click My Computer and chose Properties. Select the Advanced tab
and select the Environment Variables button. You will see Path in your list of System
Variables.

•

For Windows XP, click Start then select Control Panel. Double‐click System. Select the
Advanced tab and select the Environment Variables button. You will see Path in your list of
System Variables.

The FastExport Utility is not required; SAS/ACCESS reads large tables quite efficiently without it. For
further information, see the DBSLICEPARM option in your SAS/ACCESS to Teradata documentation.
Contact NCR if you want to obtain the Teradata FastExport Utility.
For more information about SAS/ACCESS Interface to Teradata software, please see the Teradata
chapter in SAS/ACCESS 9.2 for Relational Databases: Reference, and the SAS/ACCESS to Teradata white
paper, available on the SAS web site at
http://support.sas.com/resources/papers/teradata.pdf.
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MultiLoad
SAS/ACCESS can load large volumes of data to non‐empty tables using MultiLoad. To perform
MultiLoading, the Teradata MultiLoad Utility must be present on the system where you install SAS.
You must also modify Path, a system variable. Append two directory paths to the end of Path:
1.

The directory where mload.exe (the MultiLoad Utility) is located. Often this is
C:\Program Files\NCR\Teradata Client\bin

2.

The directory where sasmlam.dll and sasmlne.dll are located (sasmlam.dll and
sasmlne.dll are usually located in your SAS product tree, in the
!sasroot\core\sasext directory.)

To locate the Path system variable, follow the instructions for your operating system:
•

For Windows NT, right‐click My Computer and chose Properties. Select the Environment
tab and you will see Path in your list of System Variables.

•

For Windows 2000, right‐click My Computer and chose Properties. Select the Advanced tab
and select the Environment Variables button. You will see Path in your list of System
Variables.

•

For Windows XP, click Start then select Control Panel. Double‐click System. Select the
Advanced tab and select the Environment Variables button. You will see Path in your list of
System Variables.

The MultiLoad Utility is not required; SAS/ACCESS provides other options for loading tables. For
further information, see the MULTISTMT option in your SAS/ACCESS to Teradata documentation.
Contact NCR if you want to obtain the Teradata MultiLoad Utility.
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Chapter 5: Post-Installation Setup for SAS/ASSIST Software
This chapter describes how to add an optional master profile to SAS/ASSIST software. You can use a
master profile to override the default settings as sent by SAS. This allows you to provide a
customized setup for SAS/ASSIST software. With the master profile, you can control the profile
options of all SAS/ASSIST users from one central place. For information on the profile options, refer
to SAS/ASSIST Administrator’s Guide.

Adding a Master Profile
Complete the following steps to add a master profile to SAS/ASSIST software:
1.

Specify the location of the master profile by creating a new directory that all users of
SAS/ASSIST software will have read access to.
All users with write access to this directory will automatically also have write access to the
master profile in SAS/ASSIST software. Select a name that conforms to the naming
conventions at your installation. The name of this new directory must be stored in an entry in
the SASHELP library. This requires that you have write access to the SASHELP library.
On line 1 of the Editor window of the SAS Display Manager System, type the physical
pathname of the master profile directory. Execute the Save command to store this in the
SASHELP.QASSIST catalog. For example:
SAVE SASHELP.QASSIST.PARMS.SOURCE
00001 S:\SAS\ASSIST\PARMS
00002
00003
The location of the master profile is now known by SAS/ASSIST software.

2.

Create the master profile.
The first time SAS/ASSIST software is started, a master profile is created if
SASHELP.QASSIST.PARMS.SOURCE contains the name of an existing physical pathname,
and the person who starts SAS/ASSIST software has write access to this physical pathname.

3.

Customize the master profile by starting SAS/ASSIST software and selecting Setup > Profiles
> Master/group ...
If you have write access to the SAS library containing the master profile, you can specify
default values for your installation. New users will use these values as they start SAS/ASSIST
software.
Note:

If you restrict values by typing R in Status, users will not be allowed to change the values
you define.

You can run SAS/ASSIST software in two different styles ‐ workplace or block menu. The
block menu can be new style or old style. You can control this using the profile options
below.
Run workplace:
SAS/Assist style:
Run block menu new style:

Workplace

Page 23

Configuration Guide for SAS 9.2 Foundation for Microsoft Windows

SAS/Assist style:
Save selections on end:
Menu Style:
Run old style:
SAS/Assist style:
Save selections on end:
Menu Style:

Block Menu
Yes
New
Block Menu
Yes
Old

By setting the default values in the master profile, you can control if users should use the
new or old style of SAS/ASSIST software. In addition, there are many other profile options.
For more information on these options, refer to SAS/ASSIST Administrator’s Guide.
4.

Create group profiles.
From the master profile, it is possible to create group profiles to allow groups of users to have
different setups. The master profile controls group profiles and user profiles when a user is
not a member of any group. All users are indirectly controlled by the master profile when
option values are set to a restricted (R) status.
From Setup > Master/Group..., select Tools > Create Group Profile. To add users to a group
profile, select Tools > Update User Group. By default, the userid is found in the macro
variable &SYSJOBID. This value is set in the option Userid in the master profile (option type
System Administration). Change the value if your site uses another variable to keep the
userid. If the value name starts with &, it is a macro variable; otherwise, it is an environment
variable, which is set before the start of SAS 9.2.
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Chapter 6: Post-Installation Setup for SAS/CONNECT Software
TCP/IP is the access method supported for SAS 9.2 on Windows. For information about the access
methods supported by other systems, refer to Communications Access Methods for SAS/CONNECT 9.2
and SAS/SHARE 9.2. This document can be found at
http://support.sas.com/documentation/onlinedoc/.
Note:

The APPC access method is no longer supported for the Windows operating system.

Storing and Locating SAS/CONNECT Script Files
Several sample script files are shipped with SAS/CONNECT software. SAS/CONNECT software uses
these script files to establish a connection to a remote SAS session.
The SASSCRIPT configuration option points to the location of the SAS/CONNECT script files. The
SASSCRIPT option is used by SAS/ASSIST software and can be used by user‐written SCL applications.
Under Windows, the script files are installed into the !SASROOT\CONNECT\SASLINK directory by
default. The following line is added to the SASV9.CFG file when SAS/CONNECT software is
installed:
-SASSCRIPT !SASROOT\CONNECT\SASLINK
If you want to move the script files to another directory, you must edit the SASV9.CFG file and
update the SASSCRIPT option with the new directory location. This option can also be specified from
the Tools/Options/System/Communications/Networking and encryption selection in DMSEXP
mode.

TCP/IP
TCP/IP is the access method supported for SAS 9.2 on Windows. SAS/CONNECT software supports
Microsoft’s TCP/IP System Driver, which is provided with Windows.

Configuring the SAS Windows Spawner Program
The SAS Windows Spawner is stored in the !SASROOT directory and can be executed manually from
the !SASROOT directory at any time. You can run the SAS Windows Spawner as a service by
executing SPAWNER.EXE with the -install option. By default, the SAS Windows Spawner will be
installed to run with security. For complete documentation on the Windows Spawner and the
supported options, see Communications Access Methods for SAS/CONNECT 9.2 and SAS/SHARE 9.2.
Note:

If you are upgrading to SAS 9.2 and you run a spawner from a previous release as a service, you
should stop and delete the existing spawner service. The SAS 9.2 CONNECT spawner can then be
installed as a Windows service.

By default, when the SAS Windows Spawner is installed as a Windows service, it runs under the
LocalSystem userid that has all required User Rights for running the SAS Windows Spawner. If you
do not install the SAS Windows Spawner as a Windows service (run it from your system prompt), the
Windows userid used to start the SAS Windows Spawner must be the local Administrator of the
machine and must have the following User Rights:
•

act as part of the operating system
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•
•
•
•

bypass traverse checking (the default is everyone)
increase quotas
replace a process level token
log on locally (the default is everyone)

The Windows userid specified at signon needs only the User Right “log on as a batch job.”
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Chapter 7: Post-Installation Configuration for SAS/IntrNet
Software
This chapter has information for your SAS/IntrNet installation. It will help you install, configure, and
test your SAS/IntrNet components.
The procedures for installing SAS software using the SAS Deployment Wizard are described in other
documentation and are not available in this chapter. In addition, the installation of a Web server it is
not described in SAS documentation because it is the administrator’s responsibility.
When SAS/IntrNet software has been installed, configured and tested using the procedures described
in this chapter, review the latest version of the SAS/IntrNet product documentation online at
http://support.sas.com/documentation/onlinedoc/IntrNet/index.html. The “Whatʹs
New” page at this Web site lists any recent changes to the product or documentation.

Overview
All SAS/IntrNet installations are made up of two components:
1.

The SAS/IntrNet server (also referred to as the Application Server). This is where SAS
Foundation is installed.

2.

CGI Tools (also referred to as the Broker). This is where the broker.cfg file and its
supporting files are installed.

When you install SAS/IntrNet, choose between these two installation configurations:
•

Type A ‐ The SAS/IntrNet server and CGI Tools components are both installed on the same
system machine. The Web server must be installed before starting the SAS installation.

•

Type B ‐The SAS/IntrNet server component is installed on one system machine and the CGI
Tools component is installed on a different system machine. The Web server must be
installed on the CGI Tools system prior to installing CGI Tools.

Type A and Type B require different installation steps:
Type A Installation Steps

Type B Installation Steps

Confirm that the Web server software (IIS,
Apache etc.) is on the same server as your
SAS/IntrNet system.

Confirm that the Web server software (IIS,
Apache, etc.) is on the machine where you
will install the CGI Tools.

Install your SAS products. Check “CGI
Tools for the Web Server” and
“SAS/GRAPH Java Applets” in the “Select
Products to Install” menu.

On your application server system, start
your SAS installation. Uncheck “CGI Tools
for the Web Server” in the “Select Products
to Install” menu.
On your Web server system machine, start
your SAS installation. Uncheck all products
except “CGI Tools for the Web Server” and
“SAS/GRAPH Java Applets” in the “Select
Products to Install” menu.
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Type A Installation Steps

Type B Installation Steps
You can optionally check the IntrNet
Monitor or Connect Drivers.
Test the Broker

Configure a Socket Service
Start the Socket Service
Test the Socket Service
Refer to your Web server’s documentation for its installation procedures.

Installing and Configuring SAS/IntrNet Software
Install Your Web Server Software
Refer to your QuickStart Guide for a description of how to start your SAS software installation.

Install Your SAS Software
If you are performing a Type A installation (as described in the “Overview” above), confirm that
your Web server software is installed before starting your SAS software installation. Check “CGI
Tools for the Web Server” and “SAS/GRAPH Java Applets” in the Select Products to Install dialog.
If you are performing a Type B installation, do both of the following:
•

Install the SAS software on the SAS System side, unchecking “CGI Tools for the Web Server”
and “SAS/GRAPH Java Applets” in the Select Products to Install dialog.

•

Start the SAS software install on the Web server and check “CGI Tools for the Web Server”
and “SAS/GRAPH Java Applets” in the Select Products to Install dialog. SAS/IntrNet
Monitor and SAS/CONNECT Driver for Java are optional selections. Uncheck everything
else.

CGI Tools Installation Dialogs
The following windows appear for CGI Tools for the Web Server and SAS/GRAPH Java Applets for
all installations. For information about the fields, click Help on any dialog.
Customary entries are documented following each screen shown below. Customize the entries
according to your environment.
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Deployment Directory for SAS/GRAPH Java Applets:
This is part of the SAS/GRAPH Java applets installation. The applets can be installed in any valid
folder location.
This location will be available to the CGI Tools installation, which will copy the graph applets to the
/sasweb/graph directory on the Web server.
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The following are examples of common entries for popular Web servers. Customize your entries
according to your own Web server environment. These fields will tell SAS where your Web server
software is located.
Physical path corresponding to http://<your_server>/sasweb:
IIS:

C:\Inetpub\wwwroot\sasweb

Apache (Windows): C:\program files\Apache Software Foundation\Apache2.2\
htdocs\sasweb
Apache (UNIX):

/usr/local/apache2/htdocs/sasweb

Physical path for SAS/IntrNet CGI Executables:
IIS:

C:\Inetpub\scripts

Apache (Windows): C:\program files\Apache Software Foundation\Apache2.2
\cgi-bin
Apache (UNIX):

/usr/local/apache2/cgi-bin

URL for CGI Executables:
IIS:

http://<web_servername>/scripts
Example: http://abcserver.comp.com/scripts

Apache (Windows): http:// <web_servername>/cgi-bin
Example: http://abcserver.comp.com/cgi-bin
Apache (UNIX):

http://<web_servername>/cgi-bin
Example: http://abcserver.comp.com/cgi-bin
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Note that your entries for this dialog are added to the broker.cfg file. The broker.cfg file is a
text file that can be edited after the installation is complete.
Name of the Service Administrator:
(optional) Enter the name of the administrator (for example, John Doe).
Email Address of the Service Administrator:
(optional) Enter the e‐mail address of the administrator (for example, NetAdmin@comp.com).
DNS Name or IP Address of Application Server Host:
Enter the DNS name or IP address of the application server host where SAS Foundation is
located.
TCP Port Number for Application Server:
The customary default port number is 5001, but you can use any valid available port on your
system between 256 – 65535.

Click Next at this dialog unless you are using JConnect. If you are using JConnect, enter values that
are valid for your site.

Installing CGI Tools and SAS Foundation on Machines with Different Operating
Systems
Your SAS Foundation system’s operating system might be different than your CGI Tools system’s
operating system. For example, your SAS Foundation might be installed on a Windows system and
your CGI Tools might be installed on a UNIX system. The CGI Tools installation from the SAS
Deployment Wizard will detect the destination operating system and install the appropriate
operating system‐specific software.
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There are two methods to make the SAS Software Depot available to the installer on the destination
CGI Tools system. Choose the method that is appropriate for your site’s available facilities:
•

Launch the set‐up from a SAS Software Depot that resides on a remote system. You might
need to use a cross‐platform file access method such as NFS or SAMBA to connect the two
systems.

•

Create media from an existing depot using the SAS Deployment Wizard and use that media
on the host machine. This process is described more thoroughly in the SAS Deployment
Wizard Users Guide, available from Install Center
(http://support.sas.com/documentation/installcenter/92/documents/index.html).

Note:

SAS/IntrNet operation requires TCP/IP connectivity between the SAS Foundation system and the
CGI Tools system, regardless of the operating systems on which these components are installed.

Test the Web Server
To determine if the Web server is running, launch the Web server’s browser and enter
http://localhost. This will return a Web page if the Web server is running.
If you do not receive a Web page, you must debug or reinstall your Web server before continuing.

Test the Application Broker
To verify that CGI Tools was installed correctly and can access the broker.cfg file, point your Web
browser to the following URL:
Windows:
IIS:

http://<web_servername>/scripts/broker.exe

Apache: http://<web_servername>/cgi-bin/broker.exe
Other hosts:
http://your_webserver/cgi-bin/broker
Replace your_webserver with the name of the Web server. The URL path might also need to
be changed if you installed CGI Tools to a different directory. You should see a Web page similar
to the following:
SAS/IntrNet Application Dispatcher
Application Broker Version 9.2 (Build 1494)
Application Dispatcher Administration
SAS/IntrNet Samples
SAS/IntrNet Documentation - requires Internet access
If you do not receive this page, you must debug your Web server installation before continuing.
Verify that your Web server is enabled for CGI execution in the directory where you installed the
Application Broker (broker.exe and broker.cfg files). This directory was determined by what
was entered for Physical path for SAS/IntrNet CGI Executables during the CGI Tools installation
above.
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Configure a Default Application Dispatcher Service
You must create a default Application Dispatcher service to run any of the sample programs supplied
with SAS/IntrNet. You should create the default service with the SAS/IntrNet Configuration Utility
inetcfg Services can be created on Windows platforms with a configuration utility that is accessible
from the Start menu.
Perform the following steps to create and start the default service:
1.

From the Start menu, select Programs SAS (or other program group where SAS is
installed) IntrNet Create a New IntrNet Service.

2.

The IntrNet Config Utility Welcome window appears. Read the information in the Welcome
window, and then select Next to continue.

3.

Select Create a Socket Service, then select Next to continue.

4.

Type default as the name of the new service. Select Next to continue.

5.

Specify the directory where you want the configuration utility to place your service directory
and control files. The default location (under your SASROOT directory) is recommended.
Select Next to continue.

6.

Type the TCP/IP port number that you reserved for the default Application Dispatcher
service. Select Next to continue.

7.

A password is not necessary for the default service. You can add an administrator password
later if you use this service for production applications. Select Next to continue.

8.

The Create Service window displays all of the information that you specified for this service.
Verify that the information is correct and then select Next to create the service.

9.

Select Next and then Finish to complete the setup of the default service.

10. From the Start menu, select Programs SAS (or other program group where SAS is
installed) IntrNet default Service Start Interactively. Your default Application Server
should now be running.

Starting and Stopping the Default Service
As stated above, from the Start menu, select Programs SAS (or other program group where SAS is
installed) IntrNet default Service Start Interactively. Your default Application Server should
now be running.

Testing the Socket Service
1.

To make sure that the service was installed and started correctly, point your Web browser to
this URL:
Windows:
IIS:

http://<web_servername>/scripts/broker.exe

Apache: http://<web_servername>/cgi-bin/broker.exe
Other hosts:
http://your_webserver/cgi-bin/broker
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Replace your_webserver with the name of the Web server. The URL path might
also need to be changed if you installed the Application Broker to a different
directory. You should see the following Web page: SAS/IntrNet Application
Dispatcher
Application Broker Version 9.2 (Build 1494)
Application Dispatcher Administration
SAS/IntrNet Samples
SAS/IntrNet Documentation - requires Internet access
2.

Click on the Application Dispatcher Administration link to see if the Application Broker can
read the broker.cfg file. The Application Dispatcher Services Web page should open.

3.

Verify connectivity between the Application Server and the Web server. Click on the
Application Dispatcher Administration link and then click on the ping link under
SocketService default heading. If the ping is successful, you should see:
Ping. The Application Server <hostname>:<port_number> is
functioning properly.

4.

To complete installation testing, type this URL in your browser address line:
Windows:
IIS:
http://your_webserver/scripts/broker.exe?_service=default&_progra
m=sample.webhello.sas
Apache:
http://your_webserver/cgibin/broker.exe?_service=default&_program=sample.webhello.sas
Other hosts:
http://your_webserver/cgi-bin/broker?_service=default&_program=
sample.webhello.sas
You should see the string “Hello World!” in large bold type in your browser. If you do not,
add the debug option to create a log:
Windows:
IIS:
http://your_webserver/scripts/broker.exe?_service=default&_progra
m=sample.webhello.sas&_debug=131
Apache:
http://your_webserver/cgibin/broker.exe?_service=default&_program=sample.webhello.sas&_debug=131

Other hosts:
http://yourWebserver/cgibin/broker?_service=default&_program=sample.webhello.sas&_debug=131

Save the log screen on the browser for SAS Technical Support.
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Configure Additional Services
This chapter describes how to configure only a simple default Application Dispatcher service. There
are many reasons you may want to configure additional services, including segregating applications
by security or performance requirements and implementing more scalable servers. See the “Using
Services” section of the SAS/IntrNet Application Dispatcher documentation at
http://support.sas.com/documentation/onlinedoc/intrnet/index.html information
on configuring additional services, using the Load Manager, and adding pool services.
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Chapter 8: Installing SAS/SECURE Software Client Components
SAS/SECURE software includes client components that non‐SAS System client applications can use to
communicate with a SAS server in a secure environment. To use encryption between a non‐SAS
System client and a SAS server with SAS/SECURE software licensed, you must install the
SAS/SECURE client components on the client machine. The SAS/SECURE client components are
available in the SAS/SECURE folder accessible through the SAS Software Navigator.
Note:

This installation is not necessary if the SAS System is your client. The SAS System installs the
components that it needs as part of the SAS System install process.

SAS/SECURE for Windows Clients
The SAS/SECURE components needed by Windows clients can be installed by running the SAS
Software Navigator to access the SAS/SECURE Windows Client Components. The secwin.exe
executable available in this folder installs the files necessary for the IOM Bridge for COM to use the
CryptoAPI algorithms.

SAS/SECURE for Java Clients
The SAS/SECURE components for Java clients provide encryption support for Java applications. You
can incorporate this support into applications that are written using the following components:
•
•
•

SAS/SHARE driver for JDBC
SAS/CONNECT driver for Java
IOM Bridge for Java

The SAS/SECURE components needed by Java clients can be installed by running the SAS Software
Navigator to access the SAS/SECURE Java Component. This folder contains two JAR files that enable
Java clients to use the CryptoAPI algorithms:
•
•

sas.rutil.jar ‐ should be copied to the location where the client you are running gets
started
sas.core.jar ‐ included in case you do not already have one however, this will probably
not be needed

The sas.rutil.jar file should be copied to the location(s) where you installed each of the
following products. They are listed below with their respective default installation locations.
•
•
•
•

for SAS MC, <SAS_HOME>\SASManagementConsole\9.2
for OLAP Cube Studio, <SAS_HOME>\SASOlapCubeStudio\9.2
for SAS Data Integration Studio, <SAS_HOME>\SASETLStudio\9.2
for SAS Information Map Studio, <SAS_HOME>\SASInformationMapStudio\1.0

In these examples, <SAS_HOME> is specified through the SAS Software Navigator, with C:\Program
Files\SAS as the default.
After the file is copied where you need it, you can use algorithms other than sasproprietary.
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Chapter 9: Post-Installation Setup for SAS/SHARE Software
This chapter discusses the use of the TCP/IP access methods with SAS/SHARE software. TCP/IP is the
access method supported for SAS 9.2 on Windows. For information about the access methods
supported by other systems, please visit
http://support.sas.com/documentation/onlinedoc/ and refer to Communications Access
Methods for SAS/CONNECT 9.2 and SAS/SHARE 9.2.

Using the TCP/IP Communications Access Method
Communication between a SAS/SHARE server and user is handled by the TCP/IP communications
access method, which is a part of SAS 9.2 that uses underlying communications software to exchange
messages and data. The TCP/IP access method requires Microsoft’s TCP/IP Network Protocol
communications software.
Note:

The APPC access method is no longer supported for the Windows operating system.

To use the TCP/IP access method, you must have the supporting software on each workstation on
which a SAS/SHARE server or user will execute.

System Configuration for the TCP/IP Access Method
SAS/SHARE software supports Microsoft’s TCP/IP Network Protocol, which is provided with
Windows.
To define server names in the TCP/IP SERVICES file, complete the following steps:
1.

Locate the SERVICES file.
This file is located under the \windows or \winnt directory paths depending on the specific
Windows operating system and upgrade method. For example, under a machine configured with
a Windows 2000 operating system, the directory path is named
<drive letter>:\winnt\system32\drivers\etc

2.

Specify the server names and port assignments.
Each SAS/SHARE server that runs on a network must be defined as a service in the SERVICES
file. Each entry in this file associates a service name with the port number and protocol used by
that service. An entry for a SAS/SHARE server has the form:
<server name>

<port number>/<protocol>

# <comments>

The server name must be 1‐8 characters in length. The first character must be a letter or
underscore. The remaining seven characters can include letters, digits, underscores, the dollar ($)
sign, or the at (@) sign. The port number must be above 1024, as any port number equal to or less
than 1024 is reserved. The protocol must always be TCP.
An entry for a server with the name MKTSERV might look like this:
mktserv

5000/tcp

# SAS server for Marketing and Sales

The server name is specified with the SERVER= option in the PROC SERVER statement in the
server’s SAS session and in the PROC OPERATE and LIBNAME statements in user and server
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administrator programs. If the server name is not defined, you must use __port#, for example,
server= __5012.
For more information about the options used with PROC SERVER and PROC OPERATE
procedures, please refer to the SAS/SHARE 9.2 Userʹs Guide.

Client-Side Components
SAS/SHARE software includes client components that are used outside of your SAS installation.
These components are available from the SAS 9.2 Software Download site and are described below:

SAS/SHARE Data Provider
The SAS/SHARE data provider enables you to access, update, and manipulate SAS data using OLE
DB‐ and ADO‐compliant applications on Windows platforms.

SAS ODBC Driver
The SAS ODBC driver enables you to access, update, and manipulate SAS data from ODBC‐
compliant applications on Windows platforms.

SAS/SHARE Driver for JDBC
The SAS/SHARE driver for JDBC enables you to write applets, applications, and servlets that access
and update SAS data. The Java Tools package that includes the SAS/SHARE driver for JDBC also
includes the SAS/CONNECT driver for Java. If you are writing Java programs using these interfaces,
you may also want to use the tunnel feature. This optional feature can be used with the Java applets
you write to solve some common configuration problems.

SAS/SHARE SQL Library for C
The SAS SQL Library for C provides an application programming interface (API) that enables your
applications to send SQL queries and statements through a SAS/SHARE server to data on remote
hosts.

NLS Information
Sites that develop or support international applications that use SAS/SHARE software should refer to
the chapter Post‐Installation Instructions for National Language Support (NLS) on page 3.
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Chapter 10: Windows Performance Monitor and Event Log
Support
Support for Windows Performance Monitor allows advanced users and administrators to observe
some internal characteristics of SAS 9.2 Foundation. This facilitates performance analysis and
tuning of SAS 9.2.
Also, support for the Event Log allows the tracking of critical errors in SAS 9.2 Foundation and
SAS Setup.
The user account installing SAS 9.2 Foundation must have administrator privileges to install
these features, so non‐administrators will not get these features by default. They can be added
later by invoking setup.exe (found under the sas folder on the Setup Disk) with the following
command lines:
To install the Windows Performance Monitor and Event Log:
setup perfmon
To uninstall the Windows Performance Monitor and Event Log:
setup uperfmon
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